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1. Introduction 
 
The Starmon 3-D tilt is a three directional tilt angle measurement recorder.  
The recorder is a four-channel measurement device, measuring temperature, and relative 
angle movements of the housing with reference to the earth gravity.  
 
The recorder is measuring the gravity movements in three directions perpendicular to each 
other.  The X-axis is along the longitude central axis of the housing, the Y-axis is in the 
same plane positioned in a 90° angle to the X-axis and the Z-axis is a 90° angle to both X 
and Y -axis. 
 
All axis have a measuring range of approximately 180°, but the accuracy is greatly reduced 
at both ends of the measurement range. Therefore the specified valid measurement range is 
[10°- 170°]. 
 
It should be noted that if the recorder’s housing is tilted more than +/-90° from origo, then 
values from the tilt-sensor decline again.  For example a 200° angle position is read as a 
160° angle position.  This is true for all directions. 
 
Another thing that should be taken into account, is that the tilt sensor is fundamentally an 
accelerometer and fast movements can give rise to erroneous tilt measurements. 
 
Starmon 3-D tilt is calibrated at Star-Oddi, and each recorder has its calibration constants 
stored in its internal memory.  It is recommended that the recorder be recalibrated every 1-
2 years. 
 
 
Hands on description 
 
When positioning the Starmon 3-D tilt, try to set the housing in such a position that two of 
the axis are positioned as close to central point (origo) as possible, which is 90°.  So either 
X and Y, X and Z or Y and Z, are set to 90° angle, to ensure maximum range.  If the 
recorder is set to start measuring in a way that such a reading is acquired in a fixed 
position, that reading can be used to define a correction offset, as to achieve a correct 
central point/origo. 
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On-line measurement 
 
Connect to the recorder by choosing the Recorder menu and Connect command.  Then 
choose the Settings menu and OnLine command.  A window appears on the screen that 
gives measurements in real time: 
 

 
 
Figure 1.1 
 
The recorder starts the online measurements and presents temperature and X, Y and Z axis 
in a automatically updated window as in fig. 1. Now the recorder can be rotated and turned 
to find the ideal position.   
 
Using online measurement is a good way of finding the initial position of the recorder. As 
can be seen in the figure above, the 90° angle has been found for two of the axis, and hence 
the third axis shows 180°.  After the position is found, hit the ‘Quit’ button and the 
measurements are collected and displayed in graphics and tables. 
 
SeaStar is supporting software for the Starmon 3-D tilt temperature recorder.  SeaStar can 
run under Win95, Win98, Win 2000, WinXP and WinNT.   
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2. Program Installation 
 
 
This chapter describes how to install and uninstall the SeaStar software on your PC 
computer. 
 
Install 
 
The installation program is on the SeaStar CD.  Insert the CD into your compact disc 
drive.  To install the program, follow the automatic InstallShield Wizard. 
 
Follow the instructions on the screen.  You will be prompted for a directory name for your 
SeaStar program.    
 
The user is encouraged to make a shortcut to the desktop for the SeaStar program. 
 
To run the program after installation, do one of the following: 

1. Click on the Start button and choose ‘Programs’, and then ‘SeaStar’. 
2. Double click on SeaStar.exe from Windows explorer or My Computer. 
3. Double click on the SeaStar icon at the desktop (if a shortcut has been made to the 

desktop). 
 
 
Uninstall 
 
To uninstall the program, do the following: 

1. Click on the Start button in Windows. 
2. Go to Settings and Control Panel. 
3. Choose Add/Remove Programs. 
4. Choose SeaStar and click on Change/Remove, and ‘Yes to all’. 
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3. Preparation 
 
 
This chapter describes preparations that should be carried out before connecting to the 
recorder. 
 
Start SeaStar and the following window appears. 
 

 
 

Figure 3.1 SeaStar main window 
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Configuration of the communication port 
 
It is necessary to define which serial port on your PC computer you will use for the 
communication cable.  This is done in the following way: 

1. Choose the Communication command in the Settings menu.   
The Communication definition dialog box appears. 

2. Select a serial port for communications. 
3. Choose the OK button. 

 

 
 
Figure 3.2 Communication port configuration 

 
 
Before connecting to the recorder, it is important that the clock on the PC computer is 
correct.  This is important since the recorder automatically downloads the PC clock 
settings. 
 
The user is also advised to view the Settings menu, to insure that the data directory and 
data format are according user’s requirements.  The Settings menu is described in detail in 
chapter 9. 
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4. Hardware Connections 
 
 
This chapter provides details concerning the communication cable and how to connect the 
cable to the recorder. 
 
Communication cable 
 
The Starmon communication cable is an RS-232C compatible cable, specially designed to 
communicate with Starmon recorders.  An optional USB plug is also available.  The cable 
will feed power to the recorder while communicating with the PC.   
 
If the battery inside the recorder is dead, the PC and cable are still able to connect to the 
recorder and retrieve data.   
 
 
Connecting 
 
Unscrew the end cap on Starmon 3-D tilt.  The socket becomes accessible as shown in the 
following figure:   
 

 
   

Figure 4.1 Connector socket under the cap 
 
 
Connect the communication cable between the serial port of the computer and the socket 
inside the recorder.   
 
When data upload is completed and/or new measurement settings have been downloaded 
to the recorder, the user should disconnect the recorder and close the housing.  It should be 
adequate to tighten the cap firmly by hand.  Occasional lubrication of the o-ring seal is 
recommended. 
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5. Using Starmon 3-D tilt - Tutorial 
 
 
This chapter guides users through the process of utilizing SeaStar to set up Starmon 3-D 
tilt prior to recording and data retrieval. 
 
 
Step 1 - Start Program 
Start SeaStar as described in chapter 2.  Remember to carry out the software preparation 
outlined in chapter 3. 
 
 
Step 2 - Connect 
Unscrew the end cap on Starmon 3-D tilt.  Connect the communication cable between the 
serial port of the computer and the socket inside the recorder. 
 
 
Step 3 - Connect to the recorder 
Choose the Recorder menu and the Connect command.  A window appears with 
information on the recorder mode, example: 
 

 
 
Figure 5.1  Connecting to the recorder 
 
 
Press OK.  The Recorder is now on-line, as indicated at the bottom of the SeaStar 
window.   
 
 
Step 4 - Set new measurement parameters 
(If the recorder has already been set up to record data and you want to retrieve data, go 
directly to step 6).   
 
Choose the Edit menu and the New Measurement Sequence Definition command.   
 
Select the start time of recordings (date-month-year, hours-minutes).  Set the sampling 
interval (hours-minutes-seconds).   
 
If the user wants to program many recorders with the same sampling interval and start 
time, it is recommended to select Multi mode.  By choosing Multi mode, the settings are 
fixed; giving each recorder connected to thereafter, the same settings.  The recorders that 
are connected to, following the first recorder, automatically get the same settings as the 
first recorder.  This saves time in the programming process.   
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After the settings have been selected, press the OK button. 
 

 
 
  Figure 5.2 Measurement sequence definition 
 
 
Step 5 - Start a new measurement sequence 
To set the recorder in Measurement Mode (start recording), choose the Recorder menu 
and Start New Measurement Sequence command.  A window appears on the screen in 
order to verify the settings you wish to download to the recorder: 
 

 
 
Figure 5.3  Start New Measurement Sequence 
 
Press OK and the recorder will be set in Measurement Mode. 
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Step 6 - Retrieve data 
Choose the Recorder menu and the Retrieve Data command.  Data will be uploaded from 
the recorder and presented in graphical and tabular form.  With default settings, SeaStar 
automatically creates a sub-directory in the ‘Seastar’ directory, named ‘Starmon 3-D tilt’.  
In the ‘Starmon 3-D tilt’ directory, a directory named after the recorder’s serial number 
(Tnnnn) is created.  All files related to the recorder are automatically saved in the serial 
number  directory.  The default data directory can be viewed in the Settings menu, and 
Directories.  The user has the option to define a new data directory path if desired. 
 
The data is retrieved in a non-destructive manner.  This means that you can repeatedly read 
the data without erasing it from the memory.  Each time data is retrieved, a new file will 
automatically be created.  The name of the data file consists of the measurement sequence 
number and the serial number of the recorder.  The recorder cannot be loaded with new 
settings if it contains data that has not been retrieved.  This is a safety feature which 
prevents data from being accidentally lost. 
 
After data retriaval, the recorder can be set up to measure again, or it can be put into Sleep 
Mode.  While the recorder is in Sleep Mode, almost no power is depleted from the battery.  
When the recorder is on-line, the user can put it into Sleep Mode by disconnecting the 
recorder, or by choosing the Recorder menu, and Put Recorder in Sleep Mode.  To set 
the recorder in Measurement Mode, repeat steps 3, 4 and 5. 
 
 
Step 7 - Disconnect 
Disconnect the cable and close the housing.  The cap should be tightened firmly.  
Occasional lubrication of the O-ring seal is recommended. 
 
 
Step 8 – View data 
When data is retrieved from the recorder, a new file will automatically be created and 
opened in graphical and tabular form.  To open existing data files on the computer, choose 
the File menu, Select Recorder command, and then the Select Measurement command.  
When a data file has been opened, a new window appears with the data shown as a chart 
and a table.  The next chapter will describe in detail how to view and process data. 
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6. View Data 
 
 
This chapter describes how to open a data file and the options available in SeaStar for 
viewing the data. 
 
 
Open Data 
 
To open an existing data file that has already been retrieved, do the following: 
1. Choose the File menu and the Select Recorder command.  When a recorder has been 
selected, its serial number will be displayed in the blue top bar of the software.   
2. Select the data file by choosing the File menu and the Select Measurement command.   
 
The name of the data file consists of the number of times the recorder has been set up to 
measure plus the serial number of the recorder.  When the data file (.mid) has been 
selected, the chart and data tables are opened.  The following figure shows a chart and data 
table which have been opened: 
 

 
 

Figure 6.1 Chart and data table of an open file 
 
At the bottom of the SeaStar window you can view the measurement sequence number, 
which tells you the number of times the recorder has been set up to measure. 
 
 

13 



Starmon User’s Manual      SeaStar graphic supporting software 

Import 
 
Data files from other recorders than Starmon can be imported into SeaStar and viewed as 
charts and tables.  The imported file must be a text file with the extension DAT, and with 
SeaStar’s conventional DAT file structure.  See more about data files and headers in the 
Appendix. 
 
 
Buttons 
 
When the chart is opened, buttons related to the chart are displayed.   
 

 
Active Series List 
This button can be useful when working with a multi-sensor recorder, in order to select 
which parameters to display in the chart.  For example, when working with a chart 
displaying temperature and depth recordings, the user can hide the depth measurements.  
 

  
Horizontal/Vertical Gridlines 
These two buttons give the option of hiding/displaying the horizontal/vertical gridlines in 
the chart.   
 

 
Data Point Marker 
This button gives the option of displaying/hiding data points in the chart. 
 

 
Print 
The chart can be printed.  Please see chapter 8 for more details. 
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Chart Edit 
By clicking this button, the following window appears: 
 

 
 
Figure 6.2 Editing Chart 
 
This button gives several options regarding the look of the graph. The axis can be defined 
(max. and min.), titles and legend can be set visible. Under ‘Panel’ the color of 
background, borders and gradient can be selected.  Under ‘Walls - Back’ the colors and 
gradient of the graph itself can be selected.  The ‘Visible’ option must be enabled to 
activate the features. The graph can be exported in formats as jpg, gif, bitmap, metafile, 
pdf, htm and svg. 
 

 
Hide/Show table 
The data table can be either displayed or hidden using this option. 
 
Using the mouse 
 
Vertical line 
Click once on a data line in the chart, and a vertical line appears.  The maximum and 3-D 
tiltmum temperature values are now shown.  By clicking on the line and holding the left 
button on your mouse down, the line can be dragged through the chart and the data table 
will scroll along with the position of the line.     
 
Zoom 
The chart can be zoomed in on by holding down the left button of the mouse, and using the 
cursor to create a box to the right, around the desired area to zoom in on.   
 
Scroll the chart 
The chart can be scrolled upward, downwards and to the sides, by holding down the right 
button of the mouse and moving the cursor in the desired direction.   

15 



Starmon User’s Manual      SeaStar graphic supporting software 

 
Go back to initial view 
To go back to the initial view of the chart, simply hold down the left button of the mouse 
and make a box to the left with the cursor.  The position of the box on the chart is 
irrelevant. 
 
Change the axis 
By double clicking on the X and Y-axis, the measurement time and temperature range can 
be changed. 
 
Change the title 
To change the title of the chart, double click on the title of the chart. 
 
 
The View Menu 
 
When a recorder has been selected, the files in the View menu can be opened.  
  
Data Trend and Table 
This view is automatically selected when data is retrieved or a data file is opened.  If the 
chart is closed, but a recorder has been selected, this command can be selected to view the 
chart.  The software will open the latest chart that was viewed for that recorder. 
 
 
Recorder Information (RIT) 
This is a text file containing basic information about the recorder, serial number, 
production date, estimated battery life etc. 
 
Recorder Calibration Information (RCI) 
This text file contains information about the calibration constants of the recorder, 
calibration range of the parameters.  The range is both showed as decimal values (DV) and 
unit values (UV).  The survival depth of the recorder is also shown. 
 
Recorder Download Information (RDT) 
This text file contains information about the measurement sequence that was last 
downloaded into the recorder, including the start time, sampling interval and the 
measurement sequence number. 
 
Measurement Download Definition (MDT) 
This text file contains information on data downloaded into the recorder for the 
measurement file being viewed, including the start time and sampling interval. 
 
Measurement Information (MIT) 
This text file contains information concerning the measurement upload time, start date, 
start time and number of measurements in the measurement data file. 
 
Conversion Information (CIT) 
This text file contains conversion information on the units and the data file format. 
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Out Of Range (OOR) 
This text file shows the number of measurements recorded that were outside the calibration 
range. 
 
Binary Data (DAB) 
This file contains raw data of the measurements in the data file.  Calibration files are not 
calculated into the data. 
 
Converted Data (DAT) 
This is the text file for the converted data.  The DAT file as well as the other text files can 
be opened in other programs (Excel, Notepad, Word etc.).   
 
More about files in the ‘Appendix’. 
 
 
Opening data in Excel 
 
When retrieving data, the SeaStar software automatically creates a text file with the data, 
called *.DAT.  This text file can be opened in Excel and in other programs. 
 
Under the ‘Settings’ menu, ‘Preferences – Data File Format’, the default factory settings is 
set to ‘joined date and time’.  If this option is not disabled, the following is performed, for 
opening data in Excel: 
1. Excel is started. 
2. The *.dat file is found from ‘File/Open’. 
3. Excel comes up with the ‘Text import wizard’.  This is a three step process: 

a) No changes should be made in first step, so hit the next button. 
b) ‘Text qualifier’ should be set as ‘None’.  Hit the next button. 
c) Column 2, that is date and time, is set as ‘Text’.  Hit the finish button. 

4. You can now create the graph with columns B and C.  
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7. Printing 
 
 
All charts and text files can be printed from the SeaStar software.  Choose the File menu 
and the Print command.  If a chart is in the active window, the following dialog box 
appears: 
 

 
 

Figure 7.1 Print dialog box 
 
 
Orientation 
The chart can be printed in either portrait or landscape format. 
 
Margins 
By changing the margins, the chart’s length and width can be re-scaled.  The margins can 
be varied by either changing the numbers given for the left, right, top and bottom margins, 
or by moving the margin lines with the mouse by pressing and holding the left button as 
the lines are dragged. 
 
Move 
When the cursor is located on the chart, a hand becomes visible.  By clicking on the graph 
and holding down the left button of the mouse, the graph can be moved around the page to 
a desired position.   
 
Detail 
The size of horizontal and vertical gridlines as well as the texts on the X and Y-axis can be 
re-scaled by using the scroll bar.  The number of gridlines is increased when the bar is 
moved to the left.   
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8. Settings 
 
This chapter describes the options in the Settings menu.  These settings are automatically 
saved when exiting the program. 
 
Directories 
 
The path definition can be set as Default SeaStar path structure or User defined paths.  
Choose the Settings menu and the Directories command.  A dialog box appears: 
 

 
 

Figure 8.1 Directory path definition 
 
 
Default SeaStar path structure 
With default settings, SeaStar automatically creates a ‘Starmon 3-D tilt’ type directory in 
the ‘SeaStar’ directory that was created when the software was installed on the computer.  
After connecting to a recorder, another directory is automatically created in the ‘Starmon 
3-D tilt’ directory, which is named after the serial number of the recorder.  All data files 
and other files related to that  recorder are stored in this ‘serial number’ directory.  Each 
Starmon 3-D tilt recorder has its own data directory.   
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User defined paths 
If this option is selected, the User definition data directory becomes active.  The data 
path/directory can be defined by the user.  For defining a path on the network, the 
particular drive must be mapped (under Windows Explorer) in order to browse for the 
drive under ‘Add data path’. 
 
Create recorder directories 
This option is default on, and means that a recorder type and serial number directory is 
created for every recorder connected to. 
 
Browse first in user directory 
With default off, the user is first directed to the path where SeaStar was installed, to look 
for the INI file for a particular recorder.  If this option is enabled, SeaStar will start 
looking for the INI file in the user-defined directory.  More information on files and their 
structure can be found in the Appendix. 
 
 
Preferences 
 
Units 
By choosing the Settings menu, the Preferences command, and Units, a dialog box 
appears: 
 

 
 

Figure 8.2 Temperature unit dialog box 
 
 
Select units 
The user defines whether degrees Celsius or Fahrenheit are used as a unit for temperature 
measurements. 
 
Select number of decimals 
The user defines the number of decimals for temperature values displayed in SeaStar and 
for text files that are created.   
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Data File Format 
By choosing the Settings menu, the Preferences command, and Data File Format, a 
dialog box appears: 
 

 
 

Figure 8.3 Data file format dialog box 
 
 
Date format 
The user defines whether the date should be shown as dd mm yy (day, month, year), or mm 
dd yy (month, day, year). 
 
Date separation 
The user defines whether a dot or a slash should be used to separate the date. 
 
Time separation 
The user defines whether a colon or a dot should be used for the time separation. 
 
Field separation 
For the text files created, the user defines whether a tab or a space should be used to 
separate the fields. 
 
Date and time column definition 
If data is to be exported to other programs, it is recommended that the date and time be 
joined in one column. 
 
Select decimal point 
The user defines whether a comma or period is used for the values displayed in SeaStar 
and for text files that are created.   
 
 
Measurement Interval 
The default setting in the software is set to ‘Single interval’, as most users utilize.  By 
choosing ‘Multiple intervals’ the software enables programming of several different 
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sampling intervals, enabling memory saving efficiency.  By choosing the Settings menu, 
the Preferences command, and then Sampling Intervals, the following dialog box 
appears: 
 

 
 
Figure 8.4  Measurement intervals 
 
 
By choosing ‘Multiple intervals’ the effects are shown in the dialog box that appears when 
you choose the New Measurement Sequence Definition command under the Edit menu.  
With ‘Multiple intervals’ the user can define two different sampling intervals, and number 
of measurements within each interval.  The recorder can, for example, be programmed to 
switch between a narrow and a wider sampling interval.  This may be convenient for 
saving memory space in between.  More about multiple intervals in chapter 10.   
 
 
Connection 
 
Choose the Settings menu and the Connection command.  A dialog box appears: 
 

 
 

Figure 8.5   Connect and retrieve data options 
 
 
Perform CRC test when retrieving RID 
The CRC test is a safety check performed by the software when retrieving Recorder 
Information Data (RID).  If the CRC test is not successfully carried out, it means that some 
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errors have occurred in the transfer of files or constants, between the recorder and the 
computer.  If a CRC test failure occurs, the user is notified.  Normally, this option should 
always be selected. 
 
Perform clock-drift test after retrieving RID 
The software can calculate the clock drift that has occurred in the recorder.  Before 
connecting to the recorder for setting it up to measure, the PC clock must be accurately set.  
After the data-recording period and before connecting to the recorder for retrieving data, 
the PC clock must again be accurately set.  That is because clocks in PC computers tend to 
drift.  The clock drift information can be viewed in the RIT file. 
 
The drift is calculated in seconds as the difference between the recorder clock and the PC 
clock, i.e. recorder clock minus PC clock.  If the drift is negative, the recorder clock is 
lagging, and if positive, the clock drift is leading.  The drift is also calculated in ppm (parts 
per million), which is intended for finding time values in different units (hrs/min/sec) at 
various times in the measurement period. 
For example the drift in the recorder one day from start of measurements is in hours: 
24/1,000,000 x ppm, and in seconds: 24 x 60 x 60/1,000,000 x ppm. 
 
Automatic data retrieval upon connection 
By enabling this option, the software will automatically check for data in the recorder upon 
connection. 
 
 
Retrieve Data 
 
Choose the Settings menu and the Retrieve Data command.  A dialog box appears: 
 

 
 
Figure 8.6 Retrieve Data Options 
 
 
Retrieve number of data 
With default settings, the software retrieves the last measurement sequence recorded.  The 
user has the option of retrieving older data that is still in the recorder’s memory.  By 
choosing the User defined number of data, the number of measurements retrieved from 
the recorder can be set.  The total memory capacity of the recorder is 87,236 
measurements. 
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Out Of Range 
 
If measurements are outside the calibrated range, they may seem inaccurate.  The out of 
range measurements are shown in the OOR file (View – Measurement Data – Out Of 
Range Data).  The min. and max. calibration points are given in the RID file, and in this 
case it should be sufficient to go directly to ‘Edit – Reconvert Definition – Data 
Definition’, and choose ‘RID values’ under ‘Out of range decimal values settings’.  Data is 
then reconverted by choosing ‘File – Reconvert Data’.  More about reconverting in chapter 
10.   
 
The user can also define the ranges.  Choose the Settings menu, Out Of Range - UV and 
DV definition command.  A dialog box appears: 
 

 
 
Figure 8.7 Set Temperature Out Of Range (OOR) Parameters 
 
 
Decimal values 
Decimal Values (DV) are raw measurements, sometimes referred to as binary data.  The 
decimal value is between 0 and 4095, which is the range for the 12 bit AD converter.  The 
decimal values are the recorder’s calibration range.  The user should not define the decimal 
value range, unless he has obtained these values for that particular recorder from Star-
Oddi.   
 
Unit values 
The decimal values are converted to Unit Values (UV), for example a decimal value of 
2000 could give 20°C.  The user can select a specified range for temperature and pressure.  
If unit values in the data are outside the measurement calibration range of the recorder, the 
user has the option to set a max. and min. range for these unit values.   
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After selecting the unit value ranges and pressing the OK button, the following window 
appears: 
 

 
 
Fig. 8.8 Out Of Range (OOR) Correction 
 
 
If no values have been selected for the Decimal Value (DV), no correction should be 
selected.  If Unit Values (UV) ranges were specified, the user has the option to change the 
out of range measurements to the last value that was recorded before the out of range 
measurement was recorded, or have it according to the max/min unit value as specified 
earlier.  In this case the software will know if the value is under the 3-D tiltmum or 
maximum limit.  After the correction has been made, the data needs to be reconverted 
under File – Reconvert Data, and data will be changed accordingly. 
 
 
Time Synchronize Data (TSD) 
 
Choose the Settings menu, TSD definition command.  A dialog box appears: 
 
 

 
 
Fig. 8.9 Time Synchrone Data Settings 
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If the user wants to time synchronize two or more data files, it is possible to select three 
options: 1 hour, 10 minutes, or 5 minutes.  The restriction is that the sample interval 
selected must be greater than the initial interval, and it must also be dividable by the initial 
interval.  For example, if the initial interval was 15 minutes, only the 1 hour option can be 
selected for time synchronising. 
 
If the ‘Include empty cells’ is enabled, the data tables will be empty for those 
measurements in the original file that are not to be shown.   
 
If the user wants to activate this feature, the ‘Make TSD file when converting DAT-DAT’ 
must be enabled.  For changing the current measurement file with one of the three 
intervals, the data must be reconverted by ‘File – Reconvert Data’.   
 
 
Chart 
 
Time axis 
 
To change the time scale of the chart, choose the Settings menu, the Chart command, and 
Time-Axis Settings.  A dialog  box  appears: 
 

 
 
  Figure 8.10 X-Axis settings dialog box 
 
By disabling the Automatic option, the 3-D tiltmum and maximum time values become 
active.  By clicking on the Change buttons for the maximum and 3-D tiltmum values, the 
time range can be specified.  By enabling the Automatic option, the measurement time will 
go back to the  initial range. 
 
 
Value axis 
 
To change the scale settings for the value axis, double click on the Y axis scale, or choose 
the Settings menu, the Chart command, and Temperature-Axis Settings.  A dialog box 
appears: 
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  Figure 8.11 Y-Axis settings dialog box 
 
 
By disabling the Automatic option, the 3-D tiltmum and maximum measurement values 
become active.  By clicking on the Change buttons for the maximum and 3-D tiltmum 
values,  the temperature range to be shown on the chart can be specified.  By enabling the 
Automatic option, the temperature will go back to the  initial range. 
 
 
Title 
 
To change the title of the chart choose the Settings menu, the Chart command, and Title.  
A dialog box appears: 
 

 
 

Figure 8.12 Chart title dialog box 
 
 
The chart is automatically assigned the data file number as a chart title.   
To change the chart title, enter a new text string and press the OK button. 
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9. Multiple Intervals 
 
 
SeaStar has the option for setting up more than one sampling interval within a 
measurement sequence.  Reasons for wanting multiple intervals can be to save memory, 
but still be able to have frequent measurements in between.   
 
By choosing the Settings menu and Multiple Intervals command, multiple interval setup 
is activated.  Thereafter, choose the Edit menu and New Measurement Sequence 
Definition command.  The following dialog box appears: 
 

 
 
Fig. 9.1 Multiple interval selection 
 
 
Start time 
The user defines the date and time when recordings should start. 

 
Measurement interval 
The first and the second interval is defined.  Number of measurements must be defined 
within each interval.  The recorder will first take the defined number of recordings within 
the first interval, and then shift to the second interval to record the defined number of 
recordings for that interval.  The recordings will shift between two intervals and continue 
until  memory is filled or connection with recorder is establised. 
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Set mode 
The option for ‘Multi mode’ is to enable the user to fix the settings, in case many recorders 
are being programmed with the same settings.  When the ‘Multi mode’ option has been 
selected, the same settings will automatically be downloaded into the following recorders 
that connection is made with. 
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10. Reconvert Data 
 
 
In SeaStar you have the option of reconverting data that has already been retrieved.  After 
re-defining parameters, the data is reconverted by ‘File – Reconvert Data’.  The main 
reasons for reconverting data are: 

• Incorrect PC-time at measurement start-time. 
• Need for temperature unit alteration. 
• Need for data file format alteration. 

 
By choosing the Edit menu and Reconvert Data Definition, a dialog box appears: 
 

 
 

Figure 10.1 Reconvert data definition 
 
 
Set reconversion measurement sequence start-time 
If the user notifies from retrieved data that the date and clock are incorrect at the start of 
measurements, then it is possible here to specify a new start date and time.   
 
In reconversion definition use measurement intervals from 
The measurement interval is either the interval settings as shown in the measurement 
(MID) file, or if that interval is incorrect, a new and correct sampling interval is specified 
in the ‘New Measurement Sequence Definition’ command in the ‘Edit’ menu. 
 
Convert number of data according to 
You can reconvert all the data in the last measurement sequence, or you can define the 
number of measurements to be reconverted.  The user has the option to define what 
measurement range should be reconverted (for example to exclude data points when the 
recorder was above water). 
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Using the Settings menu and Preferences, you can also change the format of the 
temperature unit and the data file. 
 
For reconverting the data, the data file must be open.  To start reconverting data according 
to the new settings, choose the File menu and the Reconvert Data command.  The data 
file is reconverted and conversion data files are created (CIT, DAB, DAT).  A new chart 
file is now open.
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11. Recorder Modes 
 
 
In this chapter, we describe the three operational modes of Starmon 3-D tilt, that is the PC 
Mode, Sleep Mode and Measurement Mode. 
 
 
PC Mode 
 
If the recorder is plugged into a PC computer with the communication cable, by choosing 
the Recorder menu and the Connect command, the recorder is put into PC Mode.  At the 
bottom of the SeaStar window, the text On-line is displayed, indicating that the recorder is 
on-line and in PC Mode. 
 
While in PC Mode, the recorder will remain in an active listening stage.  The 
communication protocol is a simple master/slave arrangement, in which the recorder is the 
slave.  The slave will perform every command the PC issues, and after execution of a 
command, it will return to listening.   
 
 
Sleep Mode 
 
The user receives the recorder in Sleep Mode, but it can easily be awakened by the 
Connect command in the Recorder menu.  The recorder is put into Sleep Mode when the 
recorder is disconnected without putting it into Measurement Mode or by choosing the 
Recorder menu and then Put Recorder in Sleep Mode.  When the recorder is in this 
mode, less power is depleted from the battery than in other modes.   
 
 
Measurement Mode 
 
The recorder is put into Measurement Mode by choosing the Recorder menu, and Start 
New Measurements Sequence.  The recorder starts recording measurements according to 
the start time (date/month/year) and sampling interval (hours/min.) defined by the user. 
 
When the memory is full, the recorder shifts automatically into Sleep Mode.  Upon 
connection and command from the PC, the recorder is put into PC Mode. 
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12. Memory Organization 
 
 
The data in Starmon 3-D tilt is kept in an EEPROM memory and will not be lost if the 
battery fails or expires.  The memory of the recorder is organized as shown in the figure 
below: 
 

New recordings Unused memory/
Old recordings

VV Data memory

Settings V

 
 
     Figure 12.1     Data memory organization  
 
 
When data is retrieved from the recorder, the following occurs: 

1. The computer retrieves the data from the recorder and writes the data to the 
computer’s hard drive . 
 

2. The recorder has stopped recording, but still holds the recorded data. 
 
 
When new settings are sent to the recorder, the following will occur: 

1. New settings are sent to the recorder. 
 

2. The data memory pointer is reset to the beginning of the data memory and starts to 
write over older recordings. 

 
The organization of the memory is now as follows: 
 

Unused memory/
Old recordings

VV Data memory

Settings V

 
 

Figure 12.2  Data memory with new settings
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Appendix 
 
Directories and files 
 
 
Directory structure 
The user can choose between SeaStar’s default data directory structure (path) or define his 
own data path.  As the SeaStar program is a multi recorder type program, the directory 
structure branches from the directory where SeaStar is positioned down to type directories, 
i.e. ‘Starmon 3-D tilt’, ‘DST milli’ etc.  From there it branches again into recorder 
directories, named after the serial numbers of the recorders, designed to hold data for each 
individual recorder (data directory).  All in all it is a three level directory structure. 
 
An example of this directory structure for Starmon 3-D tilt is: 
 
C:\Seastar\   The installation directory, SeaStar.exe location. 
 
C:\Seastar\Starmon 3-D tilt\  The type directory for Starmon 3-D tilt. 
 
C:\Seastar\Starmon 3-D tilt\Z0801\ The directory for the Z0801 recorder. 
 
When connecting to a recorder for the first time, SeaStar creates the recorder directory, 
named after the serial number of the recorder. 
 
Information files 
SeaStar uses information files to store and retrieve settings.  There are two types of 
information files:  
1) The type-INI files, (for example StarmonZ.ini for Starmon 3-D tilt). 

The information type files are all in the installation directory, they contain information 
on specific settings for each type.   
The type-INI files for Star-Oddi products are: 
StarmonT.ini Starmon 3-D tilt 
StarmonP.ini Starmon TD 
DSTm.ini  DST milli 
DSTr.ini  DST milli recycle 
DSTu.ini  DST micro 
DSTc.ini  DST centi 
DSTx.ini  DST centi-ex 
DSTd.ini  DST CTD 
DSTg.ini  DST GPS 
 

2) The recorder-INI files, for example Z0801.ini contains settings information and data 
file positioning for the Z0801 recorder. The recorder-INI files are located in the 
appropriate type directory, i.e. all the Zxxxx.INI files are in the ‘Starmon 3-D tilt’ 
directory. 

 
Files locations 
As stated previously, the type-INI files are placed in the ‘Seastar’ directory, and the 
recorder-INI files are placed in the recorder type directory.  All other recorder and 
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measurement related files created by SeaStar, are placed in the appropriate recorder’s 
directory.  For example:  
C:\SeaStar\Starmon 3-D tilt\Z0801\ is a directory for the Z0801 recorder and all files 
belonging to Z0801 are placed there. 
 
If the user whishes to use his own defined data path, for example C:\Data\, then all the files 
for all the recorders, except for the INI files, are placed there.  If the user has enabled the 
“Create recorder directories” in the user path definition, individual recorder directories, 
irrelative of type, are created under the user defined path, for example: C:\DATA\Z0801\ 
for the Z0801 recorder.  The Z0801.ini file (located in the C:\SeaStar\Starmon 3-D tilt\) 
contains the path to the C:\DATA\Z0801\ directory, and all files related to the Z0801 
recorder will be placed in that particular directory. 
 
Browsing for a recorder 
When browsing for a new recorder from the ‘Select recorder’ under the files menu, the 
default method is to find a recorder-INI file in the type directory.  The INI file will then 
point to the data directory (the recorder’s directory).  If the user has enabled the “Browse 
first in the user directory” in the user path definitions, the search starts in the user defined 
directory, where a *.RID file must be selected. 
 
Recorder related files 
Every file for Starmon 3-D tilt that is recorder related has the following name format: 
Zxxxx - The name is the recorder ID (serial no.) 
 
 Ext Description      File type 
 RID Recorder  information data    Binary 
 RIT Recorder  information text    Text 
 RBD Recorder backup data     Binary 
 RDD Recorder SNMS∗ download information data Binary 
 RDT Recorder SNMS download information text  Text 
 
The recorder ID (RIT) can at a later time be opened, and the related measurement data can 
be viewed, printed and reconverted.  The RDD, RDT and DIR are download information 
files, created when a new measurement sequence is started. 
 
Measurement related files 
Every file that is specifically measurement related has the following name format: 
mmmZxxxx - The name is the measurement number + serial no. 
 
 Ext Description      File type 
 MID Measurement information data   Binary 
 MIT Measurement information text   Text 
 MDD Measurement download information data  Binary 
 MDT Measurement download information text  Text 
 CIT Measurement conversion information text  Text 

DAD Measurement Data Binary file   Binary 
DAB Measurement Data Binary file   Text 

 DAT Measurement converted data    Text 
 

                                                 
∗ SNMS: Start New Measurement Sequence 
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The MID, MIT and DAD files are created upon measurement data retrieval from the 
recorder.  The DAB, DAT and CIT files are created when converting the data.  The MDD 
and MDT are download information files and created when a new measurement sequence 
is started. 
 
 
Data files 
Upon data retrieval, three main data files are created.  
 
The *.DAD file 
This file is the raw data source file.  The data is in mixed binary form.  The user cannot 
access this file in the SeaStar program.  When converting these raw data into 
measurements, the *.MID file is needed.  The result from the conversion are two data files, 
the *.DAB and the *.DAT. 
 
The *.DAB file 
This file contains sequential binary representation of the data in columns.  The first column 
is the measurement number.  The other columns contain the measured parameters in a 
binary form. 
 
The *.DAT file 
This is the actual result file, where the measurements are converted to their natural units 
and timed.  This is a text file with columns.  The first column is the measurement number, 
the second column the date and the time, depending on the set-up.  The third column is the 
time or the first measured parameter, depending on set-up.  The following column(s) 
contain the converted measured parameters with units and number of decimals according 
to set-up.  Number of parameters can range from 1-3, and number of columns 3-6 
accordingly.   
 
 
Data header 
The *.DAT file contains a data header, which is a detailed description of how the *.DAT 
file is configured.  This feature is used by SeaStar when graphically representing the data, 
and is practical if the user wants to import the data into other applications or databases.  
Most of these descriptive items are derived from the ‘Settings’ menu and the recorder type 
definition in the ‘File’ menu. 
 
Each header item is contained in one line, and all header lines start with a #  (bookmark) 
and a number.  Then follows a description of the header item, and then 1-4 directives, all 
separated by tabs.  Eventually a comment trails the directives, preceded by a semicolon (;). 
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The following is a description of the directives contained in the data header. 
 
Item Description number of directives 
#0 Date-time: 1 
 The date and time of that particular  *.DAT file creation. 
#1 Recorder: 1 
 The recorder and sequence number, f. example 12Z0801. 
 Used for confirmation and as a graph header. 
#2 File type: 1 
 Describes file column structure, mainly if Date and Time are joined  

(0-3). 
0: Result file Number Date Time  Channels 1-3 
1: Result file Number Date & Time Channels 1-3 
2: Binary file Number Binary   Channels 1-3 

#3 Columns: 1 
 Total number of columns (3-6). 
#4 Channels: 1 
 Number of measurement parameters (1-3). 
#5 Field separation: 1 
 Separation between columns (0,1).  

0: Tab 
1: space 

#6 Decimal point: 1 
 (0,1)  
 0: Comma 
 1: Dot 
#7 Date def.: 1 
 Date format (0,1) 
 0: dd mm yy 
 1: mm dd yy 
#8 Time def.: 1 
 Time separation (0,1) 
 0: Colon (:) 
 1: Dot (.) 
#9 Channel 1: 4 

Set as left axis, normally temperature.  The four directives are: 
Axis header, unit:    Text 

 Column header, unit:  Text 
Number of decimals:  (0-3) 
Axis direction   (1,2) 
 1: Ascending 
 2:  Descending 

 
#10 Channel 2: 4 

Set as right axis, normally pressure.  The four directives are: 
Axis header, unit:    Text 

 Column header, unit:  Text 
Number of decimals:  (0-3) 
Axis direction   (1,2) 
 1: Ascending 
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  2:  Descending 
#11 Re-conversion: 1 
 Definition on conversion / Extra header in graph (0,1) 
 0: Original conversion 
 1: Reconverted 
#12 No temperature correction:  1 

Only in re-conversion, temperature correction in pressure calculations, is used as 
extra header information (0,1). 
0: Normal correction 

 1: Correction was disabled 
#13 Pressure offset correction: 2 

In pressure calculation, a zero offset can be adjusted.  The two directives are: 
Applied: (0,1) 
 0: No adjustment was made 
 1: A zero offset was adjusted. 
Adjustment value: An integer value in mbar 

#14 Channel 3: 4 
Set as extra right axis, normally salinity.  The four directives are: 
Axis header, unit:    Text 

 Column header, unit:  Text 
Number of decimals:  (0-3) 
Axis direction   (1,2) 
 1: Ascending 

  2:  Descending 
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Troubleshooting 
 
 
Connecting to the recorder 
In order to be able to communicate with the recorder, the cable must be connected to the 
correct COM port, as indicated in SeaStar.   
 
Communication errors 

1. If using a laptop, please make sure that the power cable/DC power supply are 
located as far as possible away from the communication cable. 

2. Make sure that no electrical devices/power sources are close to the communication 
cable. 

3. If a ‘Device Error’ is reported upon connection, please check if the SeaStar 
program has been opened more than once. This error can also occur if a different 
program is open, and is using the same communication port as SeaStar. 

 
CRC error 
The CRC test is a safety check performed by the software when retrieving the Recorder 
Information Data (RID).  The CRC is 
 a register in the RID file, which is calculated and placed in the recorder’s RID, when 
starting up a new measurement sequence.  When retrieving the RID from the recorder, 
SeaStar calculates the CRC from the retrieved data, and matches it against the recorder’s 
CRC register.  If they do not match, a CRC error is reported. 
 
The reason why a CRC error occurs, is most likely due to bad communication condition.  
Check the point above, under ‘Communication errors’.   
It is possible to disable the CRC check while connecting.  This is done under ‘Settings – 
Connection’.  Normally, the CRC should not be disabled, but the following scenarios are 
an exception, where CRC check can be disabled: 

a) Communication error occured while inititating a new measurement sequence. 
b) A communication error occured after data retriaval, while updating status in the 

recorder. 
c) A communication error occured while putting the recorder to sleep. 
d) A communication error occured while updating status in the recorder upon a POR 

(Power On Reset) error detection.  When connecting to the recorder and POR error 
is detected, a new status is initiated in the recorder and the RAM data is reset. 
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e) Repeated CRC error occurs, and the above does not apply/has been checked.  This 

may though produce errors in the RID file, which again may produce errors in the 
conversion of data. 

 
Disable CRC check 
In case of persistent CRC check error, the CRC check must be disabled: 

1. Go to ‘Settings – Connection’, and disable the ‘Perform CRC test when 
retrieving RID. 

2. Try connect to the recorder ‘Recorder – Connect’. 
3. If connection is OK, then examine the RIT file for possible error.  These 

possible errors may manifest themselves as a very high (>E20), or very 
low (<E-20) calibration constants.  Other errors may be abnormal 
times/dates and abnormally high measurement sequence number in the 
RIT file.  Usually SeaStar will come up with a warning if the calibration 
constants or time/date is not normal.  If the RIT shows signs of these 
error, please request record backup file (RBD) from Star-Oddi.   

4. If the recorder has been measuring data, try to retrieve the data 
‘Recorder – Retrieve Data’.  If data can not be retrieved there is fault 
with the PC com port, the communication cable or the recorder.  If data 
retrieval was ok, continue to step 5. 

5. Make a short measurement test and start the recorder in a new 
measurement sequence ‘Recorder – Start New Measurment Sequence’. 

6. Enable the CRC check ‘Settings – Connection’. 
7. Connect to the recorder after the short measurement test, ‘Recorder – 

Connect’.  If a communication/CRC error occurs, then there is fault with 
the PC com port, the communication cable or the recorder. Contact Star-
Oddi.  

8. Retrieve data from the short test ‘Recorder – Retrieve Data’.  Analyse 
the data, and verify that the values are correct. 
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Starting the recorder in a new mesurement sequence 
 
Communication errors 

1. Timeout on command echo (no response from recorder). 
Check if the cable is properly connected the PC COM port and the recorder. 
 

2. Other communication errors. 
Other communications problems can occur, but the recorder is still on-line.  The 
user is prompted to try starting the recorder again in a new measurement sequence.  
If instead, the user chooses to connect to the recorder again, a CRC error will most 
likely occur.  In that case, the user should disable the CRC check (Settings – 
Connection).   

 
 
Retrieving data from the recorder 
 
Communication errors 

1. Timeout on command echo. 
There is no response from recorder.  The recorder is off-line.  Please try to connect 
again.   

2. Other communication errors while retrieving data. 
The result of the retrieval can be viewed in the .MIT file.  Usually, if the 
communication is in order, and all the data is retrieved correctly, SeaStar will 
automaticlly convert the data from the decimal values (.DAD), to the unit values 
(*.DAT).  If this is not the case, then SeaStar may drop the conversion part, and it 
is up to the user, to either retrieve the data again, or manually re-convert the data, 
depending on the status of the retrieval. If a communication error occurs in the 
middle of data retrieval, the recorder becomes off-line.  The user must connect to 
the recorder again, and retrieve the data again. 

3. Communication errors while updating recorder status. 
In the event when communication error occurs while updating the status in the 
recorder, i.e. after retriving the data,  the CRC register in the recorder is probably 
corrupt.  Thus when connecting again to the recorder, a CRC error will likely 
occur.  In this case, the CRC check should be disabled, as described earlier in the 
‘Troubleshooting”. 

 
 
Graph and data table not displayed 
If the software has not been installed from the CD, and only the ‘seastar.exe’ file is 
running, the graph and data table will not appear.  This may be the case when the user has 
a new computer, and gets the latest version of SeaStar from Star-Oddi, runs only the 
‘seastar.exe’ file, and has not previously installed SeaStar from the CD.  The software must 
be installed from the CD (by running the ‘setup.exe’ file), because it installs the package 
for creating the graphs and tables.  The ‘seastar.exe’ file can be updated later with a new 
‘seastar.exe’ file. 
 
When data is retrieved using the ‘seastar.exe’ file only, the data is retrieved OK, although 
the graph and table will not display.  The data can be opened in Excel, or viewed after 
installing the software from the CD. 
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